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Introduction 

Governance, Risk and Compliance Controls (GRCC) provides a platform in which 

two applications run. They can impose controls by default on instances of Oracle E-

Business Suite and PeopleSoft Enterprise, and may be configured to work with other 

business-management applications as well. 

• Transaction Controls Governor (TCG) enables users to define ―models,‖ each of 

which specifies circumstances under which individual transactions would pose 

an unacceptable risk to a company. 

• Application Access Controls Governor (AACG) regulates access to duties 

assigned in business-management applications. It implements ―access policies,‖ 

which identify duties that are considered to conflict with one another because, 

in combination, they would enable individual users to complete transactions that 

may expose a company to risk. 

Within any business-management application, AACG can recognize policy con-

flicts after duties are assigned to users. In Oracle E-Business Suite or PeopleSoft 

Enterprise, version 8.5.1 can also implement ―User Provisioning‖ — it can evaluate 

access policies as roles or responsibilities are assigned to users, preventing them 

from gaining risky access.  

In earlier versions (8.0 through 8.2.1), the platform contained only AACG, and the 

product was known as Application Access Controls Governor. In version 8.5.0, TCG 

was  added to the platform; as a result the product as a whole is now named Govern-

ance, Risk and Compliance Controls. 

To run version 8.5.1, you must upgrade to it from version 8.5.0; you cannot install 

version 8.5.1 directly. To implement version 8.5.0, you may install it directly, or you 

may upgrade to it from any of versions 8.0 through 8.2.1. To perform the version 8.5.0 

installation or upgrade, see the Installation and Upgrade Guide for version 8.5.0. 

Then, to upgrade to version 8.5.1, complete the following steps. 

1. To implement User Provisioning in Oracle EBS instances, ensure that version 

7.3.1 of Preventive Controls Governor (PCG) is installed in each Oracle EBS 

instance that is subject to AACG analysis. (Earlier versions of AACG permitted 

the use of earlier PCG versions, but AACG 8.5.1 requires version 7.3.1 of PCG.) 

PCG is a set of applications which primarily apply controls within Oracle EBS, 

but which also support User Provisioning in AACG. For installation instructions, 

see the Preventive Controls Governor Installation Guide for version 7.3.1. 
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There is no similar prerequisite for implementing User Provisioning in a 

PeopleSoft instance. 

2. Upgrade to version 8.5.1 of GRCC from version 8.5.0: 

• Use the database and software components already installed for version 

8.5.0. (These are listed in the ―Prerequisites‖ section, below.) 

• Download GRCC files and  perform the GRCC upgrade. 

To complete these procedures, see Chapter 2 of this manual. Because this upgrade 

reuses the database already installed for version 8.5.0, it inherits certain informa-

tion, which need not be reconfigured. This includes: 

• ―Global user‖ configuration — criteria for identifying business-application 

users, whose IDs in those applications may vary from one application to an-

other. For more on global user configuration, see the Installation and Upgrade 

Guide for version 8.5.0. 

• Connections to business-management applications in which controls created 

in GRCC will be implemented. For more on configuring ―datasource‖ con-

nections, see the User Guide for version 8.5.1. 

3. Perform an additional Provisioning Embedded Agent (PEA) installation in each 

instance of Oracle EBS or PeopleSoft that is to be subject to User Provisioning. 

For Oracle PEA installation, see Chapter 3 of this manual; for PeopleSoft PEA 

installation, see Chapter 4.  

To upgrade from version 7.2.3 or earlier of AACG, install version 8.5.0 of GRCC 

and then upgrade to version 8.5.1. Use its migration utility to copy earlier-version 

SOD rules into the version-8.5.1 instance. (The migration process converts SOD 

rules into access policies.) For information on the migration utility, see the Appli-

cation Access Controls Governor User Guide for version 8.5.1. 

Supported Operating Systems 

GRCC runs on a server with, by preference, a Linux operating system. Windows 

Server is also supported. For details about supported operating systems, see the 

Oracle Governance, Risk and Compliance Applications Support Matrix. 

Prerequisites 

To have installed version 8.5.0 of GRCC successfully, you will have already met the 

following prerequisites. For the sake of completeness, however, ensure that the fol-

lowing are installed on the GRCC server: 

• Oracle 10g or 11g database. The certified version is 11gR1-64 bit. The system 

global area (SGA) requires 4 gigabytes. 

• Tomcat Application Server version 5.5  

If you are installing on Linux, you must have Sun Java Development Kit 1.6 or 

higher. If you are installing Windows, use Sun JDK or JRockit R27.5.0 for Java SE 

6; the latter is recommended. In any case, GRCC must have its own dedicated Java 

container. It was not designed to coexist in a container with other web applications. 
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If you are installing on Linux, add the following to the /etc/security/limits.conf file: 

*    soft    nproc     4096 

*    hard    nproc     16384 

*    soft    nofile    20480 

*    hard    nofile    65536 

If you are installing on Solaris, set the following configuration parameter in 

/etc/system to protect against exploitation of buffer overflow attacks. (There is no 

need to do this for OEL or other Linux variations.) 

noexec_user_stack = 1 

On the server or a client system, the following web browsers can display the GRCC 

interface: 

• FireFox 3.5  

• Microsoft Internet Explorer 8, with the Adobe SVG plugin available from 

http://www.adobe.com/svg/viewer/install/mainframed.html.  

Restricted Use Licenses 

Restricted-use: WebLogic Suite, Oracle Data Integrator; each of which may only be 

used with the Application Access Controls Governor or Transaction Controls Gover-

nor product. 

Additional details on restricted-use rights: 

WebLogic Suite restricted to the following components: WebLogic Server and 

Diagnostics Pack for Oracle Middleware. The GRC application can only be deployed 

within a single GRC based WLS domain. 

Restricted use Oracle Data Integrator – Target Database (restricted to use with 

Application Access Controls Governor or Transaction Controls Governor as the 

only target). 
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Upgrading GRCC 

In broad terms, complete these steps to upgrade version 8.5.0 of Governance, Risk 

and Compliance Controls to version 8.5.1: 

1. Download files to the GRCC server and prepare them for use. 

2. Install and configure the software. 

Noting Your Current Settings 

For version 8.5.0, you have already configured settings that establish connectivity 

between Governance, Risk and Compliance Controls and its database. As you upgrade 

to  8.5.1, you will need to re-enter these settings. Take note of them now, so that you 

will have them at hand when you need to re-enter them.  

1. Start your existing version-8.5.0 instance of GRCC: Open a web browser and, 

in its address field, enter the following: 

http://host:tomcat_port/grcc 

Replace host with the fully qualified domain name (FQDN) of your GRCC 

server, and replace tomcat_port with 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

2. Log on to GRCC: Supply your user name and password, and click on Login. 

3. In the Navigation panel (to the left on the GRCC interface), expand the Administra-

tion entry (click on its plus sign), and then click on Application Configuration. 

4. An Application Configuration panel displays the settings you’ve established for 

most database-connectivity parameters. (For security purposes, it does not display 

the database password.) Copy the settings. (For example, highlight the fields 

displaying your settings by dragging your mouse across them, click on Ctrl+C 

to copy the settings, open a word processor or spreadsheet, and press Ctrl+V to 

paste in the copied settings.) 
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Backing Up the GRCC Schema 

Governance, Risk and Compliaince Controls requires a schema in an Oracle 10g or 

11g database. For version 8.5.1, use the schema already created for version 8.5.0. 

Before upgrading, take a backup of your GRCC schema.  

To use the multilingual capabilities of GRCC, be  sure the database that hosts the 

GRCC schema is set up for UTF-8 encoding. Specifically, the character set should be 

set to AL32UTF8. Refer to your Oracle Admin guide for information on verifying 

or configuring your database with the recommended character set. 

Downloading Files 

Before downloading files, create a staging directory on the GRCC server. When this 

directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls Disk in your Oracle 

media pack. In its dist directory, locate the file grcc_851.zip. Copy the file to your 

staging directory, and extract its contents there.  

2. One of the files you’ve extracted is called grcc.war. Execute the following com-

mand to validate it.  

md5sum grcc.war 

In response to this command, a checksum value is returned. Ensure that it matches 

the following value: 

53a26bbe8d2958f516c5b1a2b8c71465 

Performing the Upgrade 

When the necessary files are downloaded, complete these steps: 

1. Shut down the Tomcat application server (or, if you are installing on a Windows 

server and run Tomcat as a Windows service, stop the service). 

2. For version 8.5.0, you should have created a directory for a Report Repository 

and a second directory for the storage of ETL data used by Transaction Controls 

Governor. Ensure that these directories exist, and note the path to each as you 

will need to supply them later as configuration values. 

3. Remove the directory TomcatHome/webapps/grcc, and all its contents.  

Note: Throughout this document, replace the value TomcatHome with the full 

path to the highest-level directory in which Tomcat components are installed. 

Also remove the grcc directory from the Tomcat work area (TomcatHome/work/ 

Catalina/localhost/grcc). You may want to save Tomcat logs (located at 

TomcatHome/logs) to another location, then delete them.  

4. Copy the file grcc.war from your version-8.5.1 staging directory to 

TomcatHome/webapps. This copy operation overwrites an older version of 

grcc.war. 
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Certain modifications to Tomcat settings are necessary for GRCC, but you are 

assumed to have made these modifications during installation of GRCC 8.5.0. 

There is no need to make them again.  

Moreover, if you are upgrading on a Windows server you are assumed also dur-

ing installation of GRCC 8.5.0 to have ensured that the <Connector> port setting 

of the TomcatHome\conf\server.xml file contains the value URIEncoding= 

"UTF-8".  

5. Start the Tomcat application server (or if you run Tomcat as a Windows service, 

start the service). 

6. Open a web browser and, in its address field, enter the following: 

http://host:tomcat_port/grcc 

Replace host with the FQDN of your GRCC server, and replace tomcat_port 

with 8080 (if you accepted the default value when you installed Tomcat) or 

your configured value (if you changed the default during installation).  

7. An Application Configuration panel appears, with a Properties tab selected. 

(Ignore the Analytics Integration, User Integration, and Patterns tabs.)  

In the GRCC Schema section of the Properties panel, supply the following 

information about the GRCC database. (If you are upgrading, these correspond 

to values you recorded in ―Noting Your Current Settings‖ on page 2-1.) 

• User Name: Supply the user name for the GRCC database. (In version 8.0, 

this parameter was called ag.connection.username.) 

• Password: Supply the password for the GRCC database. (In version 8.0, this 

parameter was called ag.connection.password.) 

• Confirm Password: Re-enter the password for the GRCC database. (This 

parameter did not exist in version 8.0.) 

• Port Number: Supply the port number at which the GRCC database server 

communicates with other applications. (In version 8.0, this parameter was 

called ag.connection.port.) 

• Server Identifier: Supply the service identifier (SID) for the GRCC database 

server. (In version 8.0, this parameter was called ag.connection.sid.) 

• Server Name: Supply the FQDN of the database server. (In version 8.0, this 

parameter was called ag.connection.server.) 

• Report Repository Path: Supply the full path to the Report Repository 

directory discussed in step 2 on page 2-2. (In version 8.0, this parameter 

was called ag.report.repository.path.) 

• Log Threshold: Select a value that sets the level of detail in log-file entries. 

From least to greatest detail, valid entries are error, warn, info, and debug. 

(This parameter did not exist in version 8.0.) 

• Transaction ETL Path: Enter the full path to the directory, discussed in step 

2 on page 2-2, that holds ETL data used by Transaction Controls Governor. 

(This parameter did not exist in versions eariler than 8.5.0.) 
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8. In the Application Configuration panel, select or clear check boxes in the 

Performance Configuration section: 

• Externalize Report Engine: Select the check box to enable the reporting 

engine to run in its own java process, so that the generation of very large 

reports does not affect the performance of other functionality. However, 

select the check box only if you have installed GRCC on hardware that is 

identified as ―recommended‖ in the Governance, Risk and Compliance 

Support Matrix. 

• Optimize Distributed Operation: Select the check box to increase the speed 

at which GRCC performs distributed operations such as data synchroniza-

tion. However, for this selection to have any effect, at least one datasource 

(page 2-5) must have an entry in its DB Agent field. (This entry, in turn, is a 

DB Link name configured externally to GRCC.) The Optimize Distributed 

Operation setting enhances performance only in GRCC exchanges with 

datasources with values entered in the DB Agent field.  

• Optimize Appliance-Based Operation: Select the check box to optimize 

performance if the GRCC application and GRCC schema reside on the 

same machine. Do not select this check box if the GRCC application and 

schema do not reside on the same machine. If you select this check box, you 

must enter a value in the ORACLE_HOME Path field. 

When you select the Optimize Appliance-Based Operation field, an  

ORACLE_HOME Path field appears. In it, enter the full, absolute path to your 

Oracle Home — the directory in which you have installed the Oracle data-

base that houses the GRCC schema. 

• Enable Era-Based ETL Optimization: Select this check box to cause TCG 

data synchronization to operate only on data entered in business-management 

applications after a specified date. (This setting has no impact on data syn-

chronization operations for AACG.) 

When you select the Enable Era-Based ETL Optimization field, and Analy-

sis Start Date field appears. In it, enter a date from which you want synchroni-

zation runs to recognize data changes. When you click in the field, a pop-up 

calendar appears. Click left- or right-pointing arrows to select earlier or later 

months (and years), and then click on a date in a selected month. 

9. In the Application Configuration panel, select the check boxes for up to eleven 

languages in which you want GRCC to be able to display information to its 

users. These are located in a Language Preferences section. Once selected in the 

Properties panel, these languages are available for selection by individual users 

as they configure their user profiles or as they log on to GRCC.  

Note: A Web Services Administration section contains a single field, Use Basic 

Administration. It is used for the integration of GRCC with an application whose 

database shares its user information through LDAP technology. However, there 

are limitations that could materially affect data and functionality. Therefore, you 

should configure LDAP integration in general, and enable the Use Basic Admin-

istration field in particular, only with the assistance of Oracle Consulting Services 

or another organization experienced in this type of integration for GRCC. 
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10. In the Application Configuration panel, click on the Test button to validate the 

parameter values you’ve entered. Upon passage of the test (if GRCC can con-

nect to its database and if it can read the directory path for the Report Repository), 

a Save button becomes active. Click on it to save the settings.  

11. Exit the Application Configuration panel.  

12. Shut down the Tomcat application server (or the Windows service in which it runs). 

13. If you are installing on Linux, navigate to your staging directory and, from 

there, run the script file grcc_update.sh with TomcatHome/webapps/grcc passed 

as a parameter: 

cmd> grcc_update.sh TomcatHome/webapp/grcc 

If you are installing on a Windows server, omit this step. 

14. Start the Tomcat application server, and then wait at least 10 minutes. Warning: 

During this waiting period, a prompt to restart the Tomcat application server 

may appear. If so, ignore it. (You will need to stop and restart Tomcat once 

again, but must not do so until you have waited at least 10 minutes and com-

pleted step 15.) 

15. Determine whether the installation is complete. To do so, review the GRCC log 

(TomcatHome/webapps/grcc/log/grcc.log) and determine whether processes 

have finished. They have done so when the log has stopped growing. If the log 

indicates problems, contact Oracle Support. Otherwise, move on to step 16 only 

when the log has stopped growing.  

16. Shut down the Tomcat application server (or the Windows service in which it 

runs). Then restart it.  

17. Review the GRCC log once again to search for errors in the installation or setup 

of the GRCC schema. The log includes a ―Summary of schema updates‖; if any 

status there indicates failure, search for ―ORA-‖ in the log file to find details of 

the error, and report them to Oracle Support. Otherwise, continue with step 18. 

18. Open a web browser. Clear its cache, and then, in its address field, manually 

type the following URL. (This ensures that you open a fully refreshed instance 

of GRCC, rather than a cached instance that is no longer valid.) 

http://host:tomcat_port/grcc 

Replace host with the FQDN of your GRCC server, and replace tomcat_port 

with 8080 (if you accepted the default value when you installed Tomcat) or 

your configured value (if you changed the default during installation).  

Datasources 
As noted earlier, the version 8.5.1 upgrade inherits data-source configuration from 

the version-8.5.0 installation; that is, it is already connected to business-management 

applications in which it will implement access policies. You need not repeat this 

configuration. (For information on configuring new datasources, however, see the 

Governance, Risk and Compliance Controls User Guide for version 8.5.1.) 
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GRCC assigns an ID number to each datasource. If you intend to enable User 

Provisioning for an Oracle EBS or PeopleSoft datasource (see Chapters 3 and 4), 

you need to know its datasource ID. To determine the number: 

1. Log on to GRCC. In a web browser, enter the following, in which host repre-

sents the FQDN of your GRCC server, and tomcat_port is replaced by 8080 (if 

you accepted the default value when you installed Tomcat) or your configured 

value (if you changed the default during Tomcat installation). 

http://host:tomcat_port/ags 

2. In the Navigation panel (to the left of the GRCC interface), expand the Admin-

istration entry (click on its + sign) and select (click on) the Data Administration 

entry in the Administration list. 

3. Right-click on the header row in the Data Administration panel. 

4. A menu appears. Position the mouse cursor over its Columns option; a list of 

available columns appears.  

5. In that list, select the check box for the Datasource ID column (click on it so 

that a check mark appears).  

6. Left-click anywhere outside of the menu and list of columns to close them.  

7. The Data Administration panel now displays a Datasource ID column. In it, 

note the ID number assigned to the datasource. 

If, having determined the datasource IDs for your datasources, you wish to remove 

the Datasource ID column from view, repeat this procedure but clear the Datasource 

ID check box (click on it so that the check mark disappears). 
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Installing the Oracle PEA 

In support of the AACG User Provisioning feature, install a Provisioning Embedded 

Agent (PEA) on each instance of Oracle E-Business Suite that is to be subject to AACG 

analysis. Installations on Oracle EBS 11.5.10 and R12 (12.0.4) are supported. Even 

if you have installed the PEA for version 8.5.0, you must reinstall it for version 8.5.1. 

On each EBS instance for which you want to enable User Provisioning, you must 

install version 7.3.1 of Preventive Controls Governor (PCG) before installing ver-

sion 8.5.1 of the PEA. Keep the following in mind: 

• You can install GRCC 8.5.1 on its server without first having installed PCG on 

any EBS instance. If so, however, AACG would not be able to apply User Pro-

visioning to Oracle EBS instances. You can implement User Provisioning sub-

sequently; to do so, you would first install PCG, then the PEA, on each EBS 

instance for which you want to enable User Provisioning.  

• Even after User Provisioning is enabled, you may choose to reinstall PCG on an 

EBS instance. If so, you must also reinstall the PEA on that instance. 

This chapter describes an automated PEA installer and a manual PEA installation 

process. If the Oracle EBS concurrent manager server and forms server reside on 

the same instance, attempt automated installation first, as it’s simpler. If not, or if 

the automated installer fails, use the manual process. In either case, first complete 

some preliminary steps that apply to both automated and manual installations. 

Preliminary Steps 

If you run your Oracle EBS instance in the Linux operating system, you must set a 

display option. To do so, execute the following command: 

export DISPLAY=localhost:1.0 

As you install the PEA, you must supply the username and password of a GRCC 

user. It’s recommended that you create a user called wsclient, and specify that user 

during PEA installation. For information on creating users, see the Governance, Risk, 

and Compliance Controls User Guide for version 8.5.1. 

When you configure an Oracle EBS instance as a GRCC datasource, GRCC gener-

ates a datasource ID number. You must supply that number as you install the PEA. 

Thus sequence matters: Upgrade GRCC on its server and configure each EBS instance 

as a datasource (see Chapter 2) before you install the PEA on any EBS instance.  
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In the Oracle EBS instance on which you are installing the PEA, navigate to the cus-

tom application TOP (conventionally called XXLAAPPS_TOP) created on the Preven-

tive Controls Governor forms server. Execute a directory listing to determine if it 

has a subdirectory named mesg. If not, create the subdirectory: 

mkdir mesg 

Downloading and Preparing Files 
Create a staging directory on the server that supports Oracle E-Business Suite. 

When this directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls Suite Disk in your Oracle 

media pack. On it locate grcc-peainstallation-8.5.1-SNAPSHOT-ebs-package.zip. 

Copy it to the staging directory, and extract its contents into that directory.  

The extraction should produce subdirectories of the staging directory called db, 

fndload, Forms, and lib, each of which contains files. Also, files called grcc-

peainstallation-8.5.1-SNAPSHOT.jar, install.properties, and pea.properties reside 

in the staging directory. 

2. To perform the automated installation, use a text editor to open and edit the 

install.properties file in the staging directory. (For a manual installation, this step 

is unnecessary.) Provide values for the following properties: 

• APPS_USER_NAME = APPS 

Supply the username for the database schema that supports your Oracle 

EBS instance. Typically, this value is APPS.  

• APPS_PASSWORD = apps_schema_password 

Supply the password for the Oracle EBS database schema identified in the 

previous property. 

• XXLAAPPS_USER_NAME = XXLAAPPS 

Supply the username for the database schema that supports PCG installed on 

your Oracle EBS instance. Typically, this value is XXLAAPPS. 

• XXLAAPPS_PASSWORD = XXLAAPPS_passsword 

Supply the password for the Preventive Controls Governor database schema 

identified in the previous property. 

• HOST = hostname 

Supply the host name for the Oracle EBS database server. 

• PORT = number 

Supply the port number at which the Oracle EBS database server communi-

cates with other applications. 

• SID = service_identifier 

Supply the service identifier (SID) for the Oracle EBS database server. 

• FREQUENCY = 30 

Supply a number that sets the interval, in minutes, at which two PEA concur-

rent programs are to run. GRCC User Provisioning Poll handles the approval 
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or rejection of User Provisioning requests in the Oracle EBS instance. GRCC 

User Provisioning Request Recovery transmits stored requests to GRCC 

when communications with the EBS instance have been interrupted, then 

restored. The recommended value for both programs is 30. 

3. Execute the environment file, if it is not included in the profile. Run this command: 

. $APPL_TOP/$APPLFENV 

Automated Installation 

Once you have downloaded files and prepared them, execute the following steps to 

complete an automated installation:     

1. Navigate to your staging directory. 

2. Run the installation file. Execute the following command: 

java -jar grcc-peainstallation-8.5.1-SNAPSHOT.jar -ebs 

The installation program prompts for property values required by the PEA: 

• Enter GRCC user name 

If you created a wsclient user on your GRCC instance, supply the value 

wsclient here. If not, supply the user name configured for any GRCC user. 

• Enter GRCC password 

Enter the password for the user identified in the previous property. 

• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRCC is 

installed (on which Tomcat is installed and the grcc.war file is deployed; 

see ―Performing the Installation,‖ beginning on page 2-2). To verify, ping 

the GRCC server from the server where the PEA is being installed. 

• Enter GRCC port number 

Supply the Tomcat port number — 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRCC in-

stance is installed. This URL should be /grcc/services/GrccService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 30. 

• Enter datasource ID 

Supply the datasource ID assigned by GRCC to the Oracle EBS instance in 

which you are installing the PEA. (This value is available in the GRCC Data 

Administration panel; see ―Datasources,‖ page 2-5). 

The installation program updates the pea.properties file and then executes the 

installation. 
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3. When the file finishes running, review its log file: In the staging directory, use a 

text editor to open the file debugInstall.log. It notes status for several installa-

tion stages (Status of Packages, Status of Concurrent Programs, Status of Load 

Java, and Status of Forms), as well as for overall installation.  

• If the status for each is Success, PEA is installed. Ignore the manual instal-

lation procedure. 

• Otherwise, the debugInstall.log file lists errors that have occurred at each 

stage. Either resolve the errors and retry the automated installation process, 

or complete the manual installation process (see the next section).  

Manual Installation  

If your Oracle EBS concurrent manager server and forms server reside on separate 

instances, or if the automated PEA installation has failed, execute a manual installa-

tion instead. Once you have downloaded files and prepared them, complete the fol-

lowing sections. 

Forms Installation 

First, install forms. The PEA uses forms in eleven languages, for which you will 

need to know language codes as you perform the installation. These codes include: 

D German KO Korean 

DK Danish PTB Brazilian Portuguese 

E Spanish US American English 

F French ZHS Simplified Chinese 

I Italian ZHT Traditional Chinese 

JA Japanese   

Complete the following steps: 

1. Navigate to your staging directory. 

2. Execute the following command to execute the package (PKS).  

(Here and in subsequent steps, appsSchemaName and appsSchemaPassword are the 

user name and password for the database schema used by Oracle E-Business Suite.) 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grcc_provdb_pkg.pks 

3. Execute the following command to execute the package body (PKB). 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grcc_provdb_pkg.pkb 

4. To set the environment variable, execute one of the following commands, once 

for each language. As you do, replace the placeholder CODE with the appropriate 

language code (see above). 

If you use Oracle E-Business Suite Release 12: 

export FORMS_PATH=$FORMS_PATH:$AU_TOP/forms/CODE 
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If you use an earlier version of Oracle EBS: 

export FORMS60_PATH=$FORMS60_PATH:$AU_TOP/forms/CODE 

5. Execute one of the following commands to compile the library: 

For Oracle E-Business Suite Release 12: 

frmcmp_batch module=Forms/GRCC_PROV.pll module_type=library 

userid=appsSchemaName/appsSchemaPassWord 

For earlier versions of Oracle EBS: 

f60gen module=Forms/GRCC_PROV.pll module_type=library 

userid=appsSchemaName/appsSchemaPassWord 

6. Execute the following command to copy the compiled library.  

cp Forms/GRCC_PROV.*  $AU_TOP/resource 

7. To compile the forms, execute on of the following commands, once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 3-4): 

For Oracle EBS Release 12: 

frmcmp_batch module=Forms/CODE/LAASCAUS.fmb 

userid=appsSchemaName/appsSchemaPassWord 

For earlier versions of Oracle EBS: 

f60gen module=Forms/CODE/LAASCAUS.fmb 

userid=appsSchemaName/appsSchemaPassWord 

8. To back up the compiled forms, execute the following command, once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 3-4): 

cp $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 

$XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx.orig 

(If you followed recommendations as you installed Preventive Controls Gover-

nor, you selected XXLAAPPS as the application short name, and the environment 

variable shown in this command — $XXLAAPPS_TOP — is correct. If you chose 

another application short name as you installed Preventive Controls Governor, 

make sure the environment variable in this command and the next reflects the 

application short name you created.) 

9. To copy the compiled form, execute the following command once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 3-4): 

cp Forms/LAASCAUS.fmx $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 

Concurrent Programs Installation  

Change to your staging directory and, from it, run the following commands to set up 

concurrent programs that support User Provisioning. In these commands: 

• appsSchemaName and appsSchemaPassword are the user name and password 

for the database schema used by Oracle E-Business Suite. 

• XXLAAPPSUserName is the user name for the database schema that supports Pre-

ventive Controls Governor. This value is case-sensitive.  
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• frequency is a number setting the interval, in minutes, between scheduled runs of 

concurrent programs (see the description of the FREQUENCY option on page 3-2).  

Execute the following command to execute the User Provisioning Poll  concurrent 

program: 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grccexecutable.sql XXLAAPPSUserName frequency 

Execute the following command to execute the User Provisioning Request 

Recovery concurrent program: 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grccexecrecover.sql XXLAAPPSUserName frequency 

Once this initial setup is complete, execute the following command once for each of 

the eleven supported languages, so that concurrent-program messages, parameter 

names, and descriptions are available in each language. As before: 

• Replace the placeholder CODE with the appropriate language code (see page 3-4). 

• appsSchemaName and appsSchemaPassword are the user name and password 

for the database schema used by Oracle E-Business Suite. 

• stagedir is the path to the staging directory in which you copied and extracted 

PEA files. 

FNDLOAD appsSchemaName/appsSchemaPassword 0 Y UPLOAD 

$FND_TOP/patch/115/import/afcpprog.lct stagedir/fndload/CODE/ 

AACG_CONCURRENT_PROGRAMS.ldt 

Lookup Table Insertions 

From your staging directory, execute the following command to insert records in an 

LAA_lookup table. In this command, xxlaappsSchemaName and 

xxlaappsSchemaPassword are the user name and password for the database schema 

used by Preventive Controls Governor. 

sqlplus xxlaappsSchemaName/xxlaappsSchemaPassword 

@db/addproperties.sql 

Load Java 

Complete the following steps: 

1. Set the DB environment of APPS (the Oracle EBS database) and execute the 

installation program, specifying a ―manual‖ argument: 

Java –jar grcc-peainstallation-8.5.1-SNAPSHOT.jar -ebs 

-manual 

This prepares the pea.properties file loading into the database (as specified in 

step 5). 

2. Execute the following commands. These commands should not error out: 

dropjava 

loadjava 
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3. Execute the following commands. Here (and in steps 4 and 5), appsUserName 

and appsPassword are the user name and password for the database used by 

Oracle E-Business Suite. 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.2-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.2-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.2.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.2.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.2.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.2.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing grcc.properties 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing pea.properties 

4. Execute the following commands to load the pea jar into the database.  

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grcc-encryption-8.5.1-SNAPSHOT.jar 

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grcc-peacommon-8.5.1-SNAPSHOT.jar 

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grcc-peaebs-8.5.1-SNAPSHOT.jar 

5. Execute the following command to load the modified pea.properties file into the 

database: 

loadjava –user appsUserName/appsPassword –verbose –resolve 

grcc.properties 

loadjava –user appsUserName/appsPassword –verbose –resolve 

pea.properties 

Postinstallation Steps 

Regardless of whether you used the automated or manual installation process, run 

the Generate Messages concurrent program once for each language. 

1. Log in to Oracle E-Business Suite as any user with the Application Developer 

responsibility. 
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2. Select the Application Developer responsibility, and select the Requests: Run 

option in the Application Developer Navigator. 

3. The Submit a New Request window appears. In it, select Single Request and 

click on the OK button. 

4. The Submit Request window appears. In its Name field, query for Generate 

Messages. (Press the F11 key; type the value Generate Messages in the Name 

field; press Ctrl+F11.) 

5. A Parameter window appears. In it, enter the following: 

• Language: With each run of the concurrent program, enter one of the 

language codes shown on page 3-4 

• Application: GRC Controls Custom 

• Mode: DB_TO_RUNTIME 

Click on the OK button. 

6. In the Submit Request window, click on the Submit button. 

7. A pop-up window informs you of an ID number for the concurrent request. 

Make a note of the number, and then click on the OK button to close the 

message. 

8. Optionally, verify that the request has been completed successfully: 

a. Click on View in the menu bar, then on Requests in the View menu. 

b. A Find Requests form opens. In it, click on the Specific Request radio 

button. Type the ID number of your concurrent request in the Request ID 

field, and click on the Find button. 

c. A Requests form opens. In the row displaying information about your 

request, ensure that the entry in the Phase field is Completed (you may need 

to click on the Refresh Data button), and the entry in the Status field is 

Normal. 

d. Close the Request form: Click on the × symbol in its upper right corner. 
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Installing the PeopleSoft PEA 

In support of the AACG User Provisioning feature, install a Provisioning Embedded 

Agent (PEA) on each instance of PeopleSoft Enterprise that is to be subject to AACG 

analysis. For PeopleSoft, User Provisioning requires PeopleTools 8.49, PeopleSoft 

FIN (8.9 or 9.0) or PeopleSoft HR (8.9 or 9.0), and Java. Even if you have installed 

the PEA for an earlier version, you must reinstall it for version 8.5.1. 

You can install GRCC 8.5.1 on its server without installing the PEA on PeopleSoft 

instances. If so, however, AACG would not be able to apply User Provisioning to 

PeopleSoft instances. To implement User Provisioning subsequently, install the 

PEA on each PeopleSoft instance for which you want to enable User Provisioning. 

(For PeopleSoft instances, there is no requirement to install an application compar-

able to Preventive Controls Governor, which is necessary in Oracle EBS instances.) 

As you install the PEA, you must supply the username and password of a GRCC 

user. It’s recommended that you create a user called wsclient, and specify that user 

during PEA installation. For information on creating GRCC users, see the Govern-

ance, Risk and Compliance Controls User Guide for version 8.5.1. 

When you configure a PeopleSoft instance as a GRCC datasource, GRCC generates a 

datasource ID. You must supply that number as you install the PEA. Thus sequence 

matters: Install GRCC on its server and configure each PeopleSoft instance as a 

datasource (see Chapter 2) before you install the PEA on any PeopleSoft instance.  

Downloading and Preparing Files 

Create a staging directory on the server that supports a PeopleSoft Financials or HR 

instance. When this directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls disk in your Oracle media 

pack. On it locate grcc-peainstallation-8.5.1-SNAPSHOT-ps-package.zip. Copy it 

to the staging directory, and extract its contents into that directory. 

The extraction should produce subdirectories of the staging directory called lib, 

GRCC_AGENT_85_PS_FIN90, and GRCC_AGENT_85_PS_HR90, each of which 

contains files. Also, files called grcc-peainstallation-8.5.1-SNAPSHOT.jar, 

pea.properties, and log4j.properties reside in the staging directory. 
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2. Execute the installation program to update the pea.properties file: 

java –jar grcc-peainstallation-8.5.1-SNAPSHOT.jar -psft 

The installation program prompts for property values required by the PEA: 

• Enter GRCC user name 

If you created a wsclient user on your GRCC instance, supply the value 

wsclient here. If not, supply the user name configured for any GRCC user. 

• Enter GRCC password 

Enter the password for the user identified in the previous property. 

• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRCC is 

installed (on which Tomcat is installed and the grcc.war file is deployed; 

see ―Performing the Installation,‖ beginning on page 2-2). To verify, ping 

the GRCC server from the server where the PEA is being installed. 

• Enter GRCC port number 

Supply the Tomcat port number — 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRCC in-

stance is installed. This URL should be /grcc/services/GrccService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 300. 

• Enter datasource ID 

Supply the datasource ID assigned by GRCC to the Oracle EBS instance in 

which you are installing the PEA. (This value is available in the GRCC Data 

Administration panel; see ―Datasources,‖ page 2-5). 

• Enter PeopleSoft SID 

Supply the service identifier (SID) for the PeopleSoft database server. 

• Enter PeopleSoft port: 

Supply the number for the port at which the PeopleSoft database server 

communicates with other applications. 

• Enter PeopleSoft FQDN 

Supply the fully qualified domain name of the PeopleSoft database server. 

• Enter PeopleSoft user name 

Supply the user name for the PeopleSoft database schema. 

• Enter PeopleSoft user password 

Supply the password configured for the username identified in the previous 

property. 
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• Enable PeopleSoft PEA? (y/n) 

Enter the value y to enable the PEA, or the value n to disable the PEA. 

• Enter log4j properties location 

Specify the path to a directory in which the log4j.properties file will reside 

— PS_HOME\appserv\classes\log4j.properties, in which PS_HOME represents 

the full path to the highest level directory in which PeopleSoft components 

are installed.  

(In step 3, you’ll edit a copy of this file that’s located in your staging direc-

tory. During installation, the file will be copied from the staging directory to 

a place where it can be used, and this property tells where it should be copied.) 

• Enter PEA log location 

Set the path an name of a log file that records information about communi-

cations between PeopleSoft and GRCC. The path is PS_HOME\appserv\APP 

\LOGS\grcc-peapsclient.log, in which PS_HOME represents the full path to 

the highest level directory in which PeopleSoft components are installed, 

and APP is replaced by FIN or HR, depending on whether the PEA is being 

install on an instance of PeopleSoft Financials or Human Resources. 

• Enter interval for PEA poller 

Set a time interval, in minutes, at which an ―GRCC poller‖ may be scheduled 

to run. The poller updates role assignments for PeopleSoft users whose User 

Provisioning requests have been resolved in GRCC. In the Roles panel of the 

PeopleSoft User Profiles page, a user may select a link labeled ―Schedule 

GRCC Poller‖; if so, the poller runs at intervals defined by this parameter. 

The installation program generates a temporary folder in the staging directory; it 

contains grcc-peaps-8.5.1-SNAPSHOT.jar for installation of PEA on PeopleSoft. 

3. In the staging directory, use a text editor to open and edit the log4j.properties 

file. Set the following property: 

log4j.appender.file.File = PS_HOME\appserv\APP\LOGS\grcc-

peapsagent.log 

In this value, replace PS_HOME with the full path to the highest level directory in 

which PeopleSoft components are installed, and APP with FIN or HR, depending 

on whether the PEA is being install on an instance of PeopleSoft Financials or 

Human Resources. 

Do not modify the values of other properties in the log4j.properties file. 

Installing the PEA 

Once you have downloaded files and prepared them, execute the following steps: 

1. Stop the PeopleSoft application server.  

To do so, use the psadmin utility: To start it, execute the command 

PS_HOME\appserv\psadmin (on a Linux server) or PS_HOME\appserv\psadmin.exe 

(on a Windows server). In either case, replace PS_HOME with the full path to the 



 

4-4 Oracle Governance, Risk and Compliance Controls Upgrade Guide 

highest-level directory in which PeopleSoft components are installed. If neces-

sary, see PeopleSoft documentation for information on using the psadmin utility. 

2. Copy the following files from the lib subdirectory of your staging directory to 

the PS_HOME\appserv\classes directory: 

grcc-peacommon-8.5.1-SNAPSHOT.jar 

grcc-encryption-8.5.1-SNAPSHOT.jar 

commons-logging-1.1.jar 

log4j-1.2.14.jar 

ojdbc14-10.2.0.3.jar 

3. Copy the following file from the your staging directory to the PS_HOME\appserv\ 

classes directory: 

grcc-peaps-8.5.1-SNAPSHOT.jar 

(The temporary folder was generated by the running of the installation 

program.) 

4. Copy the log4j.properties file from your staging directory to the directory you 

specified for it in the ―Enter log4j properties location‖ property when you ran 

the grcc-peainstallation-8.5.1-SNAPSHOT.jar file. 

5. Use the psadmin utility to restart the PeopleSoft application server. (See step 1 

for information on running the psadmin utility.) 

Importing a Project 

To complete the PEA installation, import a PeopleTools project: 

1. Open the PeopleTools Application Designer. Log in as a user who has the 

PeopleSoft administrator role.  

2. Navigate to Tools > Copy Project > From File… 

3. A Copy From File dialog opens. In a field labeled ―Look in:‖ navigate to your 

staging directory. This causes subdirectories of the staging directory to appear 

in the large, unlabeled field below the ―Look in:‖ field. This also causes GRCC_ 

AGENT_85_PS_FIN90 and GRCC_AGENT_85_PS_HR90 to appear in the a field 

labeled ―Select Project from the List Below,‖ and a Select button to become 

active. 

4. For PeopleSoft 9.0 Financials, select GRCC_AGENT_85_PS_FIN90 in the ―Select 

Project‖ field, and click on the Select button.  For PeopleSoft 9.0 HR, select 

GRCC_AGENT_85_PS_HR90 in the ―Select Project‖ field,  and click on the Select 

button. 

5. When the Copy from File dialog appears, click on the Copy button.  After the 

Progress dialog disappears, confirm that application objects appear in the Appli-

cation Designer project window and click on the Save All icon or File > Save 

All. 

It’s important to follow instructions in the PeopleSoft Application Import/Update 

Installation Guide when you apply an application import/update project to your data-

base. Failure to do so could corrupt your database and cause you to lose customiza-

tions that you have made to your database. 
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Resetting Passwords 

Passwords for Governance, Risk and Compliance Controls users expire, and must 

be reset, every 90 days. This gives rise to two distinct issues: 

• An admin user, which exists by default in every instance of GRCC, gives rights 

to all functionality offered by GRCC. A utility exists to reset this user’s password 

if the user account should become locked. 

• When you install a Provisioning Embedded Agent on an instance of Oracle EBS 

or PeopleSoft, you must specify a GRCC user, known conventionally as wsclient. 

When this user’s password expires and is reset on GRCC, it is out of sync with 

the password specified on each Oracle EBS or PeopleSoft instance. A utility 

exists to change the password on those instances so that it matches the password 

when it has been reset on GRCC. 

Resetting the Admin Password 

Governance, Risk and Compliance Controls comes with one user account created by 

default. Both its user name and password are admin, and it is assigned an admin role,  

which gives rights to all functionality offered by GRCC. 

Because the admin user is powerful, one is advised to create another administrative 

user and use the seeded admin user as a backup. Moreover, in the event that the admin 

user’s password cannot be reset by normal means (if, for example, the account is 

locked because a user made too many consecutive incorrect attempts to log on), the 

password can be reset through the use of  a password reset utility: 

• You can run the utility only from the command line on the server on which 

GRCC is installed. To do so, you must have privileges to run the utility on the 

server. 

• You must know GRCC schema information, including the GRCC password. 

To run the utility, execute a password-reset jar file on the GRCC server, as follows: 

java –jar grcc-utility-8.5.1-SNAPSHOT.jar 

You will then be prompted to enter GRCC schema information. Once you’ve done 

so, you will be prompted to enter a new password. It must meet password require-

ments: A password is case-sensitive and must consist of at least eight characters, 
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taken from each of four character sets: uppercase letters, lowercase letters, numbers, 

and special characters (which comprise !@#$%&*). Moreover, the password must not 

match any of the previous three passwords, and it is invalid if it matches or contains 

the user name. 

The following is sample output of the password-reset utility: 

Enter schema host name: someserver.hq.host.com 

Enter schema port: 1521 

Enter schema sid: orcl 

Enter schema username: grcc_85a 

Enter schema password: grcc_85a 

Verifying schema.  Please wait ... 

Enter new 'admin' password: 

Resetting the Password of the PEA User 

If your organization installed provisioning embedded agents (PEAs) in Oracle EBS 

or PeopleSoft instances, it specified a GRCC user during PEA installation. (It was 

recommended that a user called wsclient be created for this purpose, but any GRCC 

user could in fact have been designated.) 

Every 90 days, an administrator must log on to GRCC and reset the password for 

this user. The administrator would use the GRCC User Administration page to reset 

this password. (See the Governance, Risk and Compliance Controls User Guide.) 

Immediately after doing so, the administrator would need to change the password in 

each Oracle EBS or PeopleSoft instance on which a PEA is installed, so that it matches 

the newly changed password on GRCC. 

To reset the password on PEA instances, complete the following steps: 

1. As the PEA was installed, a staging directory was created on the Oracle EBS or 

PeopleSoft instance. Navigate to that staging directory.  

2. Execute the following command: 

java -jar grcc-peainstallation-8.5.1-SNAPSHOT.jar -changepassword 

3. The program prompts for property values required by the PEA. Enter the follow-

ing. (Except for the password, these values are the same as those specified when 

the PEA was installed.) 

• Enter GRCC user name 

Enter the user name of the GRCC user that was specified during PEA instal-

lation. As noted, the recommended value is wsclient. 

• Enter GRCC password 

Enter the new password you’ve just created in GRCC for the user specified 

during PEA installation.  

• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRCC is 

installed (on which Tomcat is installed and the grcc.war file is deployed; 

see ―Performing the Installation,‖ beginning on page 2-2). To verify, ping 

the GRCC server from the server where the PEA was installed. 
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• Enter GRCC port number 

Supply the Tomcat port number — 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRCC in-

stance is installed. This URL should be /grcc/services/GrccService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 30. 

• Enter datasource ID 

Supply the datasource ID assigned by GRCC to the Oracle EBS instance in 

which you are installing the PEA. (This value is available in the GRCC Data 

Administration panel; see ―Datasources,‖ page 2-5). 

The program updates the pea.properties file and then executes password change. 
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